A Principled Technologies report: Hands-on testing. Real-world results.

The science behind the report:

Meet the challenge of

el Meet the challenge of demanding
: workloads with the HP ZBook Power
G10 A Mobile Workstation PC

This document describes what we tested, how we tested, and what we found. To learn how these facts translate
into real-world benefits, read the report Meet the challenge of demanding workloads with the HP ZBook Power
G10 A Mobile Workstation PC.

We concluded our hands-on testing on June 15, 2023. During testing, we determined the appropriate hardware
and software configurations and applied updates as they became available. The results in this report reflect
configurations that we finalized on April 19, 2023 or earlier. Unavoidably, these configurations may not represent
the latest versions available when this report appears.

Our results

To learn more about how we have calculated the wins in this report, go to http://facts.pt/calculating-and-highlighting-wins.
Unless we state otherwise, we have followed the rules and principles we outline in that document.

Table 1: Results of our testing.

HP ZBook Power Mobile Dell™ Precision™ 3581
Workstation G10 Workstation
3DMark
Fire Strike DX11 overall score (higher is better) 19,217 15,848
Time Spy DX12 overall score (higher is better) 8,100 6,862
Fire Strike Extreme overall score (higher is better) 9,591 8,103
Time Spy Extreme overall score (higher is better) 3,811 3310
Unigine Superposition Extreme
Superposition Extreme - DX11 overall score (higher is better) 4,990 4,347
Superposition Extreme - OpenGL overall score (higher is better) 4,601 4,008
Procyon Video Editing Benchmark
Procyon Video Editing score (higher is better) 5,657 5,474
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HP ZBook Power Mobile Dell™ Precision™ 3581
Workstation G10 Workstation
PassMark PerformanceTest 11.0
Overall PassMark rating (higher is better) 10,020.3 10,143.3
CPU Mark sub-score (higher is better) 29,723.4 25,923.7
2D Graphics Mark sub-score (higher is better) 677.7 580.1
3D Graphics Mark sub-score (higher is better) 13,846.7 14,178.5
Memory Mark sub-score (higher is better) 3,230.7 3,737.7
Disk Mark sub-score (higher is better) 43,678.6 44,190.9
Cinebench R23
Multi-core score (higher is better) 15,948 11,958
SPEC®viewperf 2020 v3.1 - 2K
3ds Max composite score (higher is better) 85.29 74.38
Catia composite score (higher is better) 81.68 70.58
Creo composite score (higher is better) 96.60 117.45
Energy composite score (higher is better) 46.98 42.33
Maya composite score (higher is better) 318.62 283.91
Medical composite score (higher is better) 51.84 50.85
SNX composite score (higher is better) 329.80 282.22
Solidworks composite score (higher is better) 192.98 169.24
PugetBench for Premiere Pro
Overall score (higher is better) 565.0 538.0
PugetBench for Davinci Resolve
Overall score (higher is better) 1,667.0 1,387.0
Cinebench R23 sustained performance and thermal testing
L\P/wliLg:—ecrc;gebseLg::)ined performance score - average 15,782 12,628
»(Algr;vlzfgtgeottt)g:)temperature (degrees Fahrenheit) 70.0 700
gs\)/\/,z??sri:tetzl:) temperature (degrees Fahrenheit) 109.4 1156
(LIJQV(\TJI::siiSdEeotIec:;assis temperature (degrees Fahrenheit) 1253 1387
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MobileMark 2018 - “best power efficiency” mode

HP ZBook Power Mobile
Workstation G10

Dell™ Precision™ 3581
Workstation

Battery life (hours:min) (higher is better) 13:21 12:12
Normalized system efficiency (minutes per WHr) (higher is better) 9.651 7.546
Performance qualification score (higher is better) 963 529
Productivity sub-score (higher is better) 883 471
Creativity sub-score (higher is better) 1,142 630
Web browsing sub-score (higher is better) 886 500
MobileMark 2018 - “best performance” mode

Battery life (hours:min) (higher is better) 11:19 9:38
Normalized system efficiency (minutes per WHr) (higher is better) 8.181 5.959
Performance qualification score (higher is better) 1,350 1,561
Productivity sub-score (higher is better) 1,351 1,540
Creativity sub-score (higher is better) 1,252 1,483
Web browsing sub-score (higher is better) 1,453 1,667
MobileMark 25 - “best power efficiency” mode

Battery life (hours:min) (higher is better) 10:38 10:49
Normalized system efficiency (minutes per WHr) (higher is better) 7.687 6.691
DC performance (higher is better) 748 423
MobileMark 25 index (higher is better) 477 275
Productivity sub-score (higher is better) 646 358
Creativity sub-score (higher is better) 947 525
Responsiveness sub-score (higher is better) 570 373
MobileMark 25 - “best power efficiency” mode

Battery life (hours:min) (higher is better) 9:24 8:15
Normalized system efficiency (minutes per WHr) (higher is better) 6.795 5.103
DC performance (higher is better) 975 1,147
MobileMark 25 index (higher is better) 549 567
Productivity sub-score (higher is better) 972 1162
Creativity sub-score (higher is better) 1,081 1,312
Responsiveness sub-score (higher is better) 703 742
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System configuration information

Table 2: Detailed information on the systems we tested.

System configuration information

HP ZBook Power Mobile
Workstation G10

Dell Precision 3581 Workstation

Processor

Vendor

AMD

Intel®

Model number

Ryzen™ 7 7840HS

Core™ i7-13800H vPro Enterprise

Core frequency (GHz) 3.8-5.1 25-52
Number of cores 8 14

Number of threads 16 20

Cache (MB) 16 24

Memory

Amount (GB) 32GB (2x 16GB) 32GB (2x 16GB)
Type DDR5-5600 DDR5-4800
Speed (MHz) 5,600 4,800

Graphics #1

Vendor AMD Intel

Model number

Radeon™ 780M Graphics

Iris Xe® Graphics

Driver version

v.31.0.14003.55001

v.31.0.101.4575

Graphics #2
Vendor NVIDIA® NVIDIA
Model number RTX™ 2000 Ada RTX 2000 Ada

Driver version

v.31.0.15.2896

v.31.0.15.2852

Storage

Model Number Western Digital SN810 SK Hynix PC801
Amount (GB) 512 512

Type NVMe® PCle® Gen 4 x4 NVMe PCle Gen 4 x4

Connectivity/expansion

Wireless internet

Realtek 8852CE WiFi 6E

Intel Wi-Fi 6E AX211

Bluetooth 53 52
1x USB 3.2 Gen 1 port
1x USB Type-C with Thunderbolt 4
1x USB 3.2 Gen 1 port with PowerShare
USB 2x USB 3.1 Gen 1
2x Thunderbolt 4 port with DisplayPort
1x USB 3.1 Gen 1 Charging Port Alt Mode/USB Type-C/USB4/Power
Delivery
Video 1x HDMI 2.1 1x HDMI 2.0
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HP ZBook Power Mobile

Workstation G10 Dell Precision 3581 Workstation

System configuration information

Battery

Type Lithium-polymer Lithium-polymer
Rated capacity (WHr) 83 97

Cells 6 6

Display

Size (in.) 15.6 15.6

Type FHD (250 nits) FHD (250 nits)
Resolution 1920 x 1080 1920 x 1080
Touchscreen No No

Operating system

Vendor Windows Windows

Name 11 Pro 11 Pro

Build number or version 22H2 22621.2134 22H2 22621.2134
BIOS

BIOS name and version HP V85 Ver. 01.01.10 Dell 1.5.0
Dimensions

Height (in.) 0.90 0.89 -0.97

Width (in.) 14.15 14.09

Depth (in.) 9.21 9.19

Weight (Ib.) 4.59 4.61
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How we tested

Setting up the systems

Creating and updating the OEM Windows 11 Pro Image

1. Boot the system.

2. Follow the on-screen instructions to complete installation, using the default selections when appropriate.

3. Inthe bottom right corner, click the battery icon, and adjust the Windows Power mode (plugged in) to Best Performance.
4

Unplug the system, and in the bottom right corner, click the battery icon, and adjust the Windows Power mode (on battery) to Best
Performance. Plug the system back in.

5. Set DPI scaling to 100%, and set Screen and Sleep options to Never:

* Right-click the desktop and select Display settings.
* Under the Scale and layout section, for the Change the size of text, apps, and other items option, select 100%.
* From the left column, select Power & Sleep.

* For all power options listed under Screen and Sleep, select Never.
6.  Disable User Account Control notifications:

* Select Windows Start, type UAC, and press the Enter key.
* Move the slider control to Never notify, and click OK.
7. Run Windows Update, and install all updates available.

Launch the Windows Store app, and install all Store app updates.
9. Launch each vendor proprietary utility app installed on each system, and update any drivers or BIOS files.

®

* For Dell, run the Dell Command Update utility.
e For HP, run the HP Support Assistant utility.

10. Verify the date and time are correct, and synchronize the system clock with the time server.
11. Disable Automatic Windows Update:

* Right-click the Windows Start button.

* Select Computer Management.

* Select Services and Applications.

* Select Services.

* Scroll down, and double-click Windows Update.

e Click Stop.

* From the Startup type drop-down menu, select Disabled.

Capturing an image
1. Connect an external HDD to the system.

2. Click Windows Menu button, and type Control Panel in the search bar. Click Control Panel->System and Security->Backup and
Restore (Windows 7)->Create a system image.

Verify that the external HDD is selected as the save drive, and click Next.

Verify that all drives are selected to back up, and click Next.

Click Start backup.

At Do you want to create a system repair disc, select No, and close the dialogs.

ok w®

Restoring an image

Connect an external HDD to the system.

Press and hold the Shift key while Restarting the system.
Select Troubleshoot.

Select Advanced options.

Select See more recovery options.

Select System image recovery.

Select the User account.

Enter the system password, and click Continue.

At the Restore system files and settings screen, select Next.
Verify that the external HDD is selected, and click Next.
Once the recovery has completed, click Finish.

TSV NO O~ WDN =

- O
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Measuring performance with Procyon Video Editing Benchmark

Setting up the test

ok wbhN =~

Download and install Procyon.

Open Procyon.

Click Video Editing Benchmark.

Click Register.

Enter the license key for the Video Editing Benchmark, and click Register.

Before running the benchmarks, make sure to install a licensed version of Adobe Premiere 14.5 or higher.

Running the test

1.

Hwn
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Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.
Launch Procyon.

Click Video Editing Benchmark.

Click Run.

When the benchmark is complete, record the results.

Wait 15 minutes before rerunning the benchmark.

Repeat steps 8 through 10 twice more.

Measuring performance with Cinebench R23

Setting up the test

1.

Download and install Cinebench from https://www.maxon.net/en/downloads/cinebench-r23-downloads.

Running the test

1.

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.
Launch Cinebench.

Select File>Advanced benchmark.

Set the Minimum Test Duration to Off.

Select either CPU (Multi Core) or CPU (Single Core), and click Start.
Record the result.

Wait 10 minutes before re-running.

Repeat steps 7 through 11 twice more, and record the median result.

Measuring performance with 3DMark

Setting up the test

1.

oD

Download 3DMark from http://www.futuremark.com/benchmarks/3dmark/all.

To install 3DMark with the default options, double-click the 3DMark installer.exe file.
To launch 3DMark, double-click the 3DMark desktop icon.

Enter the registration code, and click Register.

Exit 3DMark.
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Running the test

1.

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.

To launch the benchmark, double-click the 3DMark desktop icon.

At the 3DMark Home screen, click the More Tests button.

Select the desired benchmark to run (i.e., Fire Strike, Fire Strike Extreme, Time Spy, or Time Spy Extreme).
Move the slider button to turn off the “Include Demo” feature.

Click Run.

When the benchmark run completes, record the results.

Perform steps 7 through 11 two more times for each benchmark, and report the median of the three runs.

Measuring performance with PugetBench for Premiere Pro

We used the following application:

e Adobe Premiere Pro

Setting up the test

1.

Hwn

® N o

9.

10.
11.
12.

Launch Adobe Premiere Pro.
Click through the Tutorial pop-up tips.
Close Adobe Premiere Pro.

Purchase a PugetBench for Premiere Pro license from https://www.pugetsystems.com/labs/articles/PugetBench-for-Adobe-
Creative-Cloud-1642/.

Click Get on Adobe Marketplace, and log into your Adobe account.

To install the PugetBench Premiere Pro Plug-in, click it.

Open Adobe Premiere Pro.

Click Create New Project>Create.

Click Window->Extensions—>PugetBench for Premiere Pro.

Next to License Key, click Change, and enter your license key. Click Save.
Click Download Project Files, and download the test assets.

From Downloads, extract the PugetBench for Premiere Pro 0.98 test assets.

Running the test

1.

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.

Open Adobe Premiere Pro.

In Downloads->PugetBench for Premiere Pro, open the Benchmark_Project_23.prproj file.
Click Window—>Extensions—> PugetBench for Premiere Pro.

Click Run Benchmark.

When the benchmark finishes, record the overall score.

Close Adobe Premiere Pro, and restart the system under test.

Wait 30 minutes before performing the next run.

Repeat steps 1 through 12 twice more and record the median result.
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Measuring performance with PugetBench for DaVinci Resolve

We used the following application:

* DaVinci Resolve 18 Studio

Setting up the test

NGO~ ®WDN =

9

10.
11.
12.
13.
14.

Purchase, download, and install DaVinci Resolve 18 Studio from https://www.blackmagicdesign.com/products/davinciresolve.
Launch DaVinci Resolve Studio.

When prompted, enter the DaVinci Resolve Studio registration key.

Accept default configuration options, and accept default firewall permissions.

To confirm the Resolve configuration options, click DaVinci Resolve - Preferences.

In the Memory and GPU tab, make sure the GPU processing mode is set to Auto.

Close DaVinci Resolve Studio.

Purchase a PugetBench for DaVinci Resolve license from https://www.pugetsystems.com/labs/articles/pugetbench-for-
davinci-resolve-1523/.

Download the PugetBench for DaVinci Resolve benchmark.

When the download completes, unzip the benchmark..

From the extracted benchmark folder, launch the Run PugetBench for DaVinci Resolve program.
Enter the PugetBench license Key, and click Validate.

Click Save, and close the benchmark.

Shut down the system.

Running the test

1.

Hwn
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Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.

From the extracted benchmark folder, launch the “Run PugetBench for DaVinci Resolve” program.
Click Run Benchmark.

When the benchmark finishes, record the overall score.

Wiait 30 minutes before performing the next run.

Repeat steps 1 through 9 twice more, and record the median result.

Measuring performance with Unigine Superposition

Setting up the test

1.

2.
3.
4

Purchase, download, and install the Superposition Professional benchmark from https://store.unigine.com/accounts/files.
Launch the Superposition benchmark, and click the lock icon.

To unlock the Professional version of the benchmark, enter the license key.

Close the benchmark.

Running the test

1.

Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.
Launch the Superposition benchmark.

From the drop-down preset menu, select 1080p Extreme.

From the drop-down Graphics APl menu, select either DirectX or OpenGL.
Click Run.

Record the result.

Wait 15 minutes before the next run.

Repeat steps 9 through 11 two more times.
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Measuring performance with SPECviewperf® 2020 v3.1

Setting up the test

1.

2.
3.
4.

Navigate to https://gwpg.spec.org/benchmarks/benchmark/specviewperf-2020-v3-1/, and purchase and download the vendor license
of the benchmark.

Download and unzip SPECviewperf® 2020 v3.1.
Navigate to the extracted SPECviewperf® 2020 v3.1 directory, and click the .exe file to install.
Shut down the system.

Running the test

1.

o
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Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.
Launch SPECviewperf®.

Change the iterations to 1.

Choose the resolution options you desire for testing.

Click Run.

When the test is complete, record the results.

Repeat steps 1 though 10 twice more.

Measuring performance with PassMark PerformanceTest

Setting up the test

ok wN =

Install PassMark PerformanceTest.

Download PassMark PerformanceTest from https://www.passmark.com/products/performancetest/download.php.
To begin the installation, press Install.

Select Accept to accept the license agreement, and press Next.

After the installation is complete, deselect Launch Performance Test, and press Finish.

Running the test

1.

Hwn
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Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.

To launch PassMark PerformanceTest, press the PassMark PerformanceTest icon.
To start the benchmark, press Run Benchmark.

When the test completes, record the results.

Repeat steps 6 through 8 two more times.

Report the median of the three runs.
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Measuring thermals and sustained performance with Cinebench R23
These tests require the following:

® A FLIR Ebxt Infrared Camera
* Cinebench R23

Running the test

1. Boot the system.
Select Windows Start.
Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

After the command completes, wait 5 minutes before running the test.

Launch Cinebench R23.

Select File>Advanced benchmark.

Verify that the Minimum Test Duration is set to the default 10 minutes (Test Throttling).
Select CPU (Multi Core) and click Start.

0. Record the performance results for the next five back-to-back 10-minute iterations and at the end of each run, note the ambient room
temperature, and take a skin temperature photo with the FLIR Eéxt infrared Camera of the top and bottom. Report the hottest spots.

Hwn
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Measuring battery life with MobileMark 2018

This test requires an X-Rite - i1Display Plus colorimeter.

Avoiding antivirus software conflicts

MobileMark 2018 is not compatible with any virus-scanning software, so we uninstalled any such software present on the notebook PCs
before we installed the benchmark.

Avoiding pre-installed software conflicts
MobileMark 2018 installs the following applications, which its test scripts employ:

Productivity

* Adobe Acrobat® Pro DC

e AutolT 3.3.14.2

* Google Chrome

® Microsoft Excel 2016

* Microsoft OneNote 2016

* Microsoft Outlook 2016

* Microsoft PowerPoint 2016
* Microsoft Word 2016

* Windows Zip

Creativity

* Adobe Photoshop CC
* Adobe Lightroom Classic CC
e CyberLink PowerDirector® 2015

Web Browsing

* Google Chrome
* Microsoft Movies & TV
If any of these applications already exist on the system under test, they could cause problems with the benchmark due to software conflicts.

To avoid any such issues, we uninstalled all conflicting pre-installed software applications—including different versions of any of the programs
MobileMark 2018 uses—before we installed the benchmark.
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Adjusting display brightness and power settings

The brightness of a system’s display affects its battery life. Therefore, BAPCo requires that, before you test with MobileMark 2018, you ensure
the brightness of the notebook’s monitor is greater than or equal to 200 nits in the center of a completely white screen while the notebook

is unplugged and running on battery power. The measurement follows the standards from the Video Electronics Standards Association
(www.vesa.org).

We complied with this standard for all our tests by setting each notebook PC's brightness as close to 200 nits as we could without going
below that level. We used the following procedure before we started each test. Note: This procedure assumes we began with the system
plugged into the power supply.

To create a completely blank, white screen, open Microsoft Paint by clicking Start@All Programslll AccessoriesZPaint.
Press Ctrl+W to open the Resize and Skew dialog.

Under Horizontal and Vertical, enter 200, and click OK.

Click the View tab.

To view a white screen, click Full screen.

To allow the screen to warm, wait 45 minutes.

Nooakrwbd=

Unplug the system from the power supply, and measure the display’s brightness using a luminance meter in the center of the screen.
(We used an X-Rite - i1Display Plus colorimeter.)

8. If the reading is below or significantly greater than 200 nits, adjust the screen brightness to as close to 200 nits as you can without going
under, and retest:

a. Click the Windows Start button.
b. Inthe Windows Start search box, type display settings
c. Adjust the slider to change the Display brightness to the correct percentage that produces no less than 200 nits.

9. Allow the notebook to run on battery power for 10 minutes, re-measure the display, and adjust the brightness up or down as necessary.
10. Verify that the notebook saved the brightness setting by plugging in the system, unplugging it, and taking another reading.

Using the MobileMark built-in configuration tool

This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
3. Additionally, makes OPTIONAL changes that help ensure best results.

The configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required

e Disables User Account Control (UAC)
* Set DPI Scaling to 100%

e Disables Low Battery Actions

e Disables Network Proxies

* Disables System Sleep and Hibernate
* Disables Windows Update

* Enables Windows Search

Level 2 - Recommended

e Create BAPCo power scheme

* Set Power Plan Type to Balanced

* Set CPU Adaptive Mode

e Disables Battery Saver Dimming

* Verifies Battery Saver Threshold

e Disables Disk Defrag

e Disables Windows Error Reporting

e Disables Windows Lock Screen

* Disables Windows Pop-ups

e Disables Screen Saver and Monitor Timeout
e Disables Windows Sidebar/Gadgets
* Disables Desktop Slideshow

¢ Disables Windows Defender

¢ Disables Windows Firewall

* Set Font Smoothing
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Level 3 - Optional

* Disables Hard Disk Timeout
e Disables System Restore
® Ignores Laptop Lid Close
We chose the official BAPCo “Run Benchmark” default as outlined in the BAPCo MobileMark2018 User Guide (http://bapco.com/

wp-content/uploads/2019/03/BAPCo_MobileMark2018_user_guide_v1.3.pdf), which runs the benchmark using the Required and
Recommended options.

Setting up the performance-qualified battery life test

1. On a separate PC, install the i1Profiler software from https://www.xrite.com/categories/formulation-and-quality-assurance-software/
iTprofiler, and connect the X-Rite - i1Display Plus colorimeter to that PC.

2. On the system under test, verify that the wireless adapter is enabled and connected to a wireless router that is not connected
to the internet.

3. On the system under test, verify that the Lower screen brightness when using battery saver is turned off:

* Select Windows Start, type Battery saver, and press the Enter key.
* Next to Turns on at 20%, click the down arrow. Next to Lower screen brightness when using battery saver, toggle the button to Off.

4. On the system under test, verify that the volume is set to 50%.
5. On systems with AMD processors, disable Vari-Bright to prevent the screen from automatically dimming:

e Launch AMD Software.
e Click the Settings gear icon.
* Select the Display tab, and disable Vari-Bright.

6. Verify that the screen brightness is set to no less than 200 nits.
7. Install MobileMark 2018 with the default options.

Running the performance-qualified battery life test
1. Boot the system.

Select Windows Start.

Type cmd, and press Ctrl+Shift+Enter.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

Moo

After the command completes, wait 5 minutes before running the test.
Launch MobileMark 2018.

Click on the Settings gear icon.

Verify that Conditioning Run is enabled.

9. Enter a name for the benchmark run.

® N oo

10. To return to the main menu, click the Back button.
11. Click Run Benchmark.
12. When prompted, unplug the AC power adapter. The test will begin immediately.

The benchmark is complete when the system under test has fully depleted its battery and is no longer operational when running
on battery power.

We executed the MobileMark 2018 benchmark three times on the system and took the median battery life score run as the representative
performance score result for that test.
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Measuring battery life with MobileMark 25

This test requires an X-Rite - i1Display Plus colorimeter.

Avoiding antivirus software conflicts

MobileMark 25 is not compatible with any virus-scanning software, so we uninstalled any such software present on the systems before we
installed the benchmark.

Avoiding pre-installed software conflicts
MobileMark 25 installs the following applications, which its test scripts employ:

Productivity

* Adobe Acrobat Pro DC

* Audacity

* Corel WinZip 24.0 Enterprise

* Google Chrome

* Microsoft Excel 2019 Professional Plus VL

* Microsoft Outlook 2019 Professional Plus VL

* Microsoft PowerPoint 2019 Professional Plus VL
* Microsoft Word 2019 Professional Plus VL

* Shotcut

Creativity

* Adobe Photoshop CC
* Adobe Lightroom Classic CC
* Adobe Premiere Pro CC
If any of these applications already exist on the system under test, they could cause problems with the benchmark due to software conflicts.

To avoid any such issues, we uninstalled all conflicting pre-installed software applications—including different versions of any of the programs
MobileMark 25 uses—before we installed the benchmark.

Using the MobileMark built-in configuration tool

This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
3. Additionally, makes OPTIONAL changes that help ensure best results.

The configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required

e Disables User Account Control (UAC)
e Set DPI Scaling to 100%

e Disables Low Battery Actions

e Disables Network Proxies

* Disables System Sleep and Hibernate
* Disables Windows Update

* Enables Windows Search

e Disables WinSAT
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Level 2 - Recommended

* Create BAPCo power scheme

* Set Power Plan Type to Balanced
* Set CPU Adaptive Mode

e Disables Battery Saver Dimming

* Verifies Battery Saver Threshold

e Disables Disk Defrag

* Disables Windows Error Reporting
e Disables Windows Lock Screen

* Disables Screen Saver and Monitor Timeout
e Disables Windows Security Center
e Set Font Smoothing

Level 3 - Optional

e Disables Hard Disk Timeout

e Disables System Restore

® Ignores Laptop Lid Close

* Enables Dark Mode

* No Wait for OpenMP Threads

We chose the official BAPCo “Run Benchmark” default as outlined in the BAPCo MobileMark25 User Guide (https://bapco.com/wp-content/
uploads/2021/09/bapco_mobilemark25_user_guide_v1.1.pdf), which runs the benchmark using the Required and Recommended options.

Setting up the performance-qualified battery life test

1. On a separate system, install the i1Profiler software from https://www.xrite.com/categories/formulation-and-quality-assurance-software/
iTprofiler, and connect the X-Rite - i1Display Plus colorimeter to that PC.

2. On the system under test, verify that the wireless adapter is enabled and connected to a wireless router that is not connected
to the internet.

3. On the system under test, verify that the Lower screen brightness when using battery saver is turned off:

* Select Windows Start, type Battery saver, and press the Enter key.

* Next to Turns on at 20%, click the down arrow. Next to Lower screen brightness when using battery saver, toggle the button to Off.
4. On the system under test, verify that the volume is set to 50%.
5. On systems with AMD processors, disable Vari-Bright to prevent the screen from automatically dimming:

* Launch AMD Software.

e Click the Settings gear icon.

* Select the Display tab, and disable Vari-Bright.

6. Verify the system is no less than 250 nits.
7. On the system under test, install MobileMark 25 with the default options.
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Running the performance-qualified battery life test
1. Boot the system.

2. Select Windows Start.

3. Type cmd, and press Ctrl+Shift+Enter.

4. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do notinteract with the system until the
command completes.

5. After the command completes, wait 5 minutes before running the test.

6.  Launch MobileMark 25.

7. Click Run Benchmark.

8.  Click the Brightness Profiler button.

* Allow the white screen to warm up for 30 minutes. After 30 minutes, click Skip.
* At the Panel Dark Luminance pop-up, to use the value that is queried from the display, select Yes.
* Place the X-Rite - i1Display Plus colorimeter in the outlined spot on the screen.
* On the system under test, toggle the F1 button to turn off the test overlay.
* On the colorimeter system, start i1Profiler program, and select Advanced.
e Click Display, and click Profiling.
* Next to Luminance, click the drop-down menu and select Measure.
* In the drop-down menu that appears below, select Paper in booth.
* In the box with the image that says, “Place your paper in the light booth,” scroll down so that you can click the Measure button.
* On the system under test, adjust the slider until the Target White luminance is met on the colorimeter system.
* Once the correct Target White luminance is met on the test PC, click Done.
9. Click Continue.
10. The test will begin immediately. When prompted, unplug the AC power adapter.

The benchmark is complete when the system under test has fully depleted its battery and is no longer operational when running
on battery power.

We executed the MobileMark 25 benchmark three times on the system and took the median battery life score run as the representative
performance score result for that test.

Read the report at https://facts.pt/10hRA59

This project was commissioned by HP and AMD.

‘ Principled

Technologies®

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:

Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. specifically disclaims
any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any implied warranty of fitness for any
particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that Principled Technologies, Inc., its employees and its
subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any alleged error or defect in any testing procedure or resullt.

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if advised of
the possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in connection with
Principled Technologies, Inc.’s testing. Customer's sole and exclusive remedies are as set forth herein.
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